Margill Loan Manager

Automatic / Overnight Tasks

Automatic tasks, also known as “Overnight tasks”, allow the system to perform certain operations which are done once a day when
Margill Loan Manager (MLM) is launched. These tasks, such as the daily total computations and alerts, for large databases, could
add many minutes when launching MLM.

These operations can be programmed in order to be generated outside normal business hours thus eliminating some waiting time.
Moreover, it is possible to set an automatic backup of the MLM data at 1:00 AM, for example, without having the program running.
The server or computer where MLM is installed must of course be on or in sleep mode and the backup folder must be accessible.
Automatic tasks allow the generation of reports, Alerts and automatic emails to be generated and sent to the Borrowers at another
time than overnight. They can even be programmed many times per day, as needed. This then:

e avoids the need to send emails in the middle of the night which can be lost in the “mass” of emails received during the

night by the borrowers.

o allows the notification of a MLM user that the condition of one of the Alerts was met on that same day. This way, the user

can immediately intervene instead of being advised only on the next day.

With “MLM_Overnight_tasks.exe” and the “Windows Task Manager”, tasks can be set to be performed in the background at the
right time and with no need of human intervention.

Steps for setting automatic tasks:

1. Select tasks to be done in MLM via “MLM_Overnight tasks.exe”

2. Schedule automatic tasks with the Windows “Task Manager”
O Particular task conditions

1. Select tasks to be performed in MLM via “MLM_Overnight_tasks.exe”
Go to Settings > System settings (Administrators). Click on “Automatic / Overnight Tasks”

¥ System Settings

= X
Default Directories

Interest Rate File: | C:\Users\Sophie\Desktop'\MLM 4.4\Tables\ \ EA
Tax File: | C:\Users\Sophie\Desktop\MLM 4.4\ Tables\ [ 1
Tables folder: | c:\Users\Sophie\DesktopuALM 4.4\Tables\ | 3
Help file (F1): | C:\Users\Sophie\Desktop\MLM 4.4\GPM-Manuel. pdf \ C
User settings| System settings (Administrators)

General Settings

Unlock Records / Alerts Custom Fields Internet Connection

Borrower Maximum Credit Field Scroll Menus Email Connection

Mandatory Fields Line Payment Statuses Data and Backups

Automatic / Overnight Ta:-ks] Custom Column Titles Column Fees: Automatic

? Suggested maximum number of days between “Pmt Date” and “Pmt Due Date": |_5|

? Attached Files, maximum size (MB): [ 1 -

? D Alow to change the "Expected Payment” amount when Line status is "Due Payment”

? Number of decimals displayed (Interest Rate) |__—‘:‘

? Number of days "Unmanaged Records" (Main Window) ‘jl Do not display option
Modules

Currencies Electronic Funds Transfer Custom Report settings

Credit Renartine Persanal | non Misnlav Returned Checks

In this window, the Administrator decides which tasks are to be accomplished.
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Apart from the automatic backup, unchecked tasks in this window and/or unplanned in the Windows Task Manager will be
generated automatically, by default, every time MLM is launched. Automatic backups can only be created with this tool.

0 Automatic / Overnight Tasks

Automatic Tasks

7 Automatic change of “Due Pmt - Unpaid™ to Unpaid payment on scheduled payment date.

Default Line status to change to: Unpaid Pmt -
Overnight Tasks Open LOG

This section allows to activate features/calculations that will be executed via the Windows Task Scheduler, and usually
launched every night, after midnight.

The program to be launched is called: MLM_Overnight_tasks.exe

Automatic Backup
Data folder: ChUsers\marcp\OneDrive'\Bureau\5.2 bonne BDY
Size: 2,67 GB

Database folder: C:\Users\marcp\OneDrive\Bureau's.2 bonne BO\DE.
Size: 2,03 GB

? [] Back-up only the DB folder (Database only)

Number of successive automatic back-ups to keep in the folder: 3
PS. Backups and log file will be created in the backup folder / MLM_Automatic_backup.

|:| Definitively delete old Folders (will not be available in Recycle Bin)
Check EFT to date (Due Pmt --= Paid Pmt)

O
Recompute To Date” data (Balances, Interest...).

Generate daily alerts/emails.

-

Rebuild the indexes and compress data files every 3 Days

Automatic Reports

Save ) Cancel (=)
How it works = =

The “MLM_Overnight_tasks.exe” application can be launched automatically for one or more of the following tasks:

e  Automatic backup

All MLM data (usually under MLM Data) will be saved. This is a backup that can become quite large eventually. The
complete software installation folder is NOT included in the backup. It will only be backed up if the DB folder is in this
MLM installation folder.

If the “Back up the DB folder only (Database only)” sub-option is activated, only this folder will be backed-up thus taking
up less space. Other data not specifically included in the DB folder will be excluded.

In addition, the Administrator can decide on the number of automatic successive backups to be saved.

Unless otherwise specified in the “Data and Backup” window (Tools > Settings > System settings (Administrator)), the
backup copies will be automatically saved in the “MLM_Automatic_backup” folder.

e  Check EFT to date (Due Pmt --> Paid Pmt)

This option automatically updates Records with pre-authorized payments that were submitted to the EFT provider via the

“Pre-authorized payments” tool: the “Due Pmt” Line status is changed to “Paid Pmt” (or as chosen by the Administrator
in System settings > Electronic Funds Transfer).

r Margill
“& Loan Manager

¥ System Messages

Description Subject % Date created | ]
The credit card (VISA) for Borrower Jacques Pelletier, J.P. Inc. expires 1217 2 n
Credit Card t 2018-01-22 13:31
(MM/YY). Please contact the Borrower to obtain the new card information. ! Gt

e Recompute "To Date" data (Balances, Interest...)
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These calculations can be generated starting at midnight in order to be already updated when users access MLM. Many
minutes of waiting can be avoided this way.

Generate daily Alerts / Emails

Alerts and automatic emails (accessible via the Line status Alerts) can be generated during the night and/or one or more
times per day, as needed.

NOTE: In order for daily alerts and automatic emails to be generated whether OR NOT at the same time as the other tasks,
the “Generate Daily Alerts / Emails” box must be checked. When planning tasks in Windows, it will be possible to set
separate tasks at different times and frequencies, as needed.

Rebuild the indexes and compress data files every X days

After reindexing, index access is optimized. Reindexing may be required following the loss or alteration of the index file.
This loss or alteration can render the application unusable, unstable or simply much slower than usual. Possible causes of
loss or corruption of the index: Technical problem (power outage...), abnormal shutdown, physical removal of an index
file. Indexation sometimes increase the database's speed.

With this option, you can automate the reindexation process which could be performed every week for example. There is
no need to reindex daily.

For the reindexing to run correctly overnight, it is imperative that all instances of MLM are closed. Please ensure that
all users have closed the software at the end of the day.

Automatic Reports

This module allows you to set up reports that can be launched automatically using the Windows Task Scheduler.

The Automatic Report Setup window allows you to produce "Record List" reports and "Transaction Reports" (including all
desired fields) based on the relevant dates, in the format that suits you, including all Records or certain Records from an

Advanced Query and saving the files generated in the specified location.

In order for the report(s) to be produced, the REPORTS argument (see page 8 — “Particular task conditions” section)
must be activated: REPORTS=1 or 2, 3, 4 etc.




Y Automatic Report Setup

Report Send to

-Report
|dentifiar: 1 7 [ ExportTo s
Type: Record List - Mame: Accounting report (Accrual basis)

Description:  Acct report

-Dates
i) Full report Current Date Mode: ¥ Today, end of day
) From COrigination date to Current* Date
? 0 Last 1 Monthis) ¥ | to Current* Date " Yesterday, end of day
) Current* date only (0:00 to midnight)
700 Next day(s], 5 days(s) after Current* Date ? D Include all Records as selected no matter the date(s)

20 Preceding Calendar Month

* Current Date = Transactions, Interest and Balances, Today at the end of the day, depending on the "Current Date Mode”

Current Date transactions and interest are always included except when Current Date is the last line of the payment schedule in which case the
day's interest is always excluded.

Other important information about these reports

-File
Destination Folder: ChUsers'ymarcp'\Desktop\Overnight reports =
MName : test23

© oTet sV Excel M

e Always overwrite existing report in Destination Folder

= Keep existing report and add incremental value to report’s name  (Mame_001) Initial Value 136 [up to & digits)
e Keep existing report and add date to report’s name [Mame_20200518) Farmat YYMMOD -
-Records

& All Records
" Advanced Query A

TEST

0)

—
Save () Cancel |

Automatic export to Salesforce

By checking this box, the data contained in the Salesforce "report" will be transferred to the Salesforce
application.

In order for this option to be available, it is necessary to create a "Record List" report and include Salesforce
mapping information.

“Send to” tab

The "Send to" tab allows you to automatically send an email including the desired report to a recipient, the first

in the list, and the following in certified copy. Simply select the email template from the drop-down list and
enter the email addresses.

¥ Automatic Report Setup

Report Send to

-Send Report by Email to:
Email Template Credit Line status

* Email Address

boml

accounting@myco.com
bigboss@myco.com

==

* Click in the column to enter an Email Address.
If you enter more than one email, the first will be the redpient and the others will receive carbon copies [Cd.

-FTP Server

Move a copy to an FTP Server

FTP Server Name Corp FTP server - Edit Mew

Remote folder autorepor‘ts|

The report can also be placed automatically in a folder on a FTP server. For an FTP server, still under the "Send

4.
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2.

to" tab, "FTP Server" section, using the "New" button, configure the FTP server and test the connection using
the “Test connection” button:

= FTP Setup
FTP Server Setup
Protocol FTP -  Name Corp FTF server
Address 209.32,555.66
User JohnDoey Port number 22
Password sesenene Test connection

Ignore certificate errors

Description  Corp FTP server

Save @ Cancel Ifj

Schedule automatic tasks with the Windows “Task Scheduler”

The MLM_Overnight_tasks.exe file (application) included with the software must be launched automatically in order to perform

one or more of the chosen tasks described above in “Select the tasks to perform in MLM...”.

How to set and launch this application in Windows:

In the Windows File Manager, go to Control Panel > Systems and Security > Administration Tools > Task Scheduler.

Click on “Create Basic Task...” (or “Create Task” which requires a little more experience):

(5]

| File Action View Help

ew | 2F BE

() Task Schcduler(lecfc‘) Name SR TiiggersHt Actions
v a1, Task Scheduler Library E =
"2 AVG 5 GoogleUpdateTasiMachineCore  Ready  Multiple "Mm -~
| Hewlett-Packard Y GoogleUpdateTaskMachinellA Reacy At 1228 T Creste Basic Task..,
1 Microsoft ' GoogleUpdateTaskUser5-1-5-21-..  Ready At=18. %  Create Task..
| MySQL 2 GoogleUpdatelaskUser5-1-5-21-...  Ready At 524 | l P
| NCH Softwere 3 GoogleUpdateTaskUserS-1-5-21-. Ready  At9:18 limsiitico
| wWPD (% GoogleUpdateTaskUserS-1-5-21-_ Ready  At524| | |3 Display All Running Tasks
£ > [i. Enable All Tasks History
General Triggers Actions Conditions Settings 4 |» | | £ NewFolder.
Name: IMLM Overnight 7 View »
A r i Refresh
Location:  \
Author MARKETING \Alexandra Gelinas Hely

Enter a name and a description for the task and click on “Next”.
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e
=
5 Tasl E] Create a Basic Task

* Lol i
1 i
] Use this wizard to quickly schedule a common task. For more advanced options or settings
Trigger such asm triggers, use the Create Task command in the Actions pane,
| Action Name: MLM Task
|
| Finsh Descriptioff | Margil automated tazks ]
(R ]| e

Select the frequency at which the task is to be accomplished and click “Next”. Daily is the most common frequency.

]

ile
.o
5Tasl (D] Task Trigger
* L

|

| Creste a Basic Task When do you want the task to start?
\
fcee _______JORe
Action
| Qw
| Finish ety
O Monthly

) One ime

() When the computer starts

() When | log en

() When a specific event is logged

< Back Next >

Had you chosen “Create Task” (instead of “Create Basic Task”), many more options would have been available including running
tasks more than once a day. This could be useful to automatically send data to a third-party system such as a Customer Relations
Management (CRM) to provide balances or other data on an hourly basis for example. Microsoft Task Scheduler allows tasks to be

run every 5 minutes if needed. This is not recommended since will drain system resources.
Choose the start date and time at which the task is to be accomplished and click “Next”.

@

File

¢ = -
® Tos) E] Daily
v Al

| Create a Basic Task i

| Start: | 1/ 472018 [F+ I 2:00:00 AM :'» | "] Synchronize across time zones
' Thi
gger
l Dash
Bl Recur every: |1 days
I Action
Finish




Select the “Start a program” Action and click “Next”.

1:00 AM every day
911 Create Basic Task Wizard

log

5
o% Create a Basic Task
e Tigger What action do you want the task to perfform?

— Daily
"'1

— (®) Start 2 program
_| Finish O Sendt s e-mséil (deprecatedt
‘ (O Display 2 message (deprecated)

—

In the “Start a program” window, click on “Browse”.
Select the file named “MLM_Overnight_tasks.exe” located in the MLM installation folder. Click on “Open”.

~
File =5
reate Basic Task Wizard
= ‘
@ Tos ET') Start a Program L
v Lol
| pe %
| CresteaBasicTask ¢ « 4 || « Program Files x36) > MLM v & SearchMM o
> | Trigger
| Day Organize v New folder = @
Acti ~ . & T '
Resicts !  Creative Cloud Fil Hamea ype
5] MUMini / Configuration
Finish 3 Dropbox | MLM.wx WX File
& OneDrive -»l MLM_Overnight_tasks.exe Application
& MLM_Repair.exe Application
& This PC "] MLM _Repair.vx W
W0Objects |, i S N
| I i,
File name: [MLM_O»'ernight_tasks.m v 5Ifils [ | i v
Open il Cancel

Once the file is chosen, click on “Next” and “Finish”.

@ Summary

Create 2 Basic Task
Trigger Name:
Deity Description: ‘
Action
Start a Program

Trigges: Dadly; At 10:44 AM every day |
Adione | Start a peogram; "\\DUNK-G3BACT\Volume_T\Data\Program files\WLM £ 5\\

tmvmmtuxmmmumm
When you chick Fimsh, the new task will be created and added to your Windows schedule.

<Back [E] Cancel

The task is now configured and will be started at the next planned time and date. IMPORTANT: Notice in the image above, the

7.




“Open the Properties dialog for this task when | click Finish”. It is recommended to check this box in order to set a few more settings.
The two settings circled below may have to be checked. Please see with your IT manager.

General Triggers Actions Conditions Settings History (disabled)
Name: mim

Location: \

Author: DESKTOP-UGSBON2\david
Description:
Security options

When running the task, use the following user account:
david Change User or Group...
) Run only when user is logged on
Run whether user is logged on or not
| Do not store password. The task will only have access to local computer resources,

Run with highest privileges
(] Hidden Configure for:  Windows Vista™, Windows Server™ 2008

0K ; Cancel

These options are also accessible under the General tab in the Task Properties (accessible by double clicking on the task itself in

the main Windows Task Scheduler window).

Particular task conditions

Itis possible to set several automatic tasks with different frequencies to perform particular operations. For example, make a backup
copy once a day after midnight without generating the automatic Alerts / Emails. Or generate only the automatic Alerts / Emails
at certain times of the day without doing the backup and without recalculating the totals.

It is possible to generate the tasks in 3 modes with these execution settings.

Mode Settings Effect

General (None) All tasks checked in the "Maintenance and Automatic Tasks"

settings window will be generated without exception.

Alerts only AlertsOnly Only the "Generate daily Alerts / Emails" task will be
performed when this setting is configured.

Warning: the "Generate daily Alerts / Emails" option must be
activated in MLM for this setting to work. Simply adding this

argument is not sufficient.

Without alerts NO_Alerts All tasks checked in the overnight / automatic tasks settings

will be performed, except the Alerts / Emails.

Reports choice REPORTS=x Only the "Automatic reports" task will be performed when
x is report Identifier | this setting is configured.

Example: REPORTS=1 | By adding the unique report identifier, followed by a
semicolon if there are several to generate during this task.
Example: REPORTS=1;3;5;6




The argument is compulsory for the report(s) to be

produced.
VoPay Pre- VOPAY The “Check Submissions progress” button on the EFT
validation EFT Transmission window would ordinarily be used for EFT pre-
validation.

On the other hand, if a large batch of EFT transactions are
simultaneously sent to VoPay, the processing time may
become high for pre-validation. It is then possible to check
the submission progress via an Overnight Task. Issues will
then be reported in the Overnight Tasks log file.

This Task will query VoPay for the transactions status and
these will be updated in Margill as accepted or declined EFTs.
Declined transactions will then be reported in the Overnight
Tasks log file and a user will need to contact the Borrower to
manage the payment.

In the following example, at 12:30 PM, each day, the “Generate daily Alerts / Emails” task will be performed. During the night, at
1:00 AM, every day, the other automatic tasks that were chosen in the MLM settings will be performed:

(B Launch Screen Grasp First Ready When the task is created or modified

(5 MLM Alerts Ready At 12:30 PM every day

(% MLM Task Ready At 1:00 AM every day

(5 MySQLNotifierTask Ready At 919 AM every Tuesday every 4 weeks, sta

In order to add the “AlertsOnly” or “NO_Alerts” conditions to a task in the Windows Task Manager, simply add the argument in

the window for this purpose during the “Start a program” step:

1w A !V!ly uﬂ)'

1

2]

e j Start a Program
er

of

ot "
* Create a Basic Task
er

| Trigger Program/script:
I Daily "C:\Program Files (x85)\MLM\MLM_Overnight_tasks,exe" Browse...
Action -
| EETTITIN ¢ s st (oo, T
"| Finish

Start in (optional):

WARNING: the arguments must be written with the precise texts above in order to work.

Suggested scenario:

We would possibly want this:

1. Do abackup copy and calculate the totals once a day. This task can be performed after midnight.

2. Launch the Alerts and send automatic emails at the start of the work day (not during the night). This, in order to prevent
emails (notifying borrowers of payments that will be collected in their bank accounts) from being lost in the “mass” of emails
received by the borrower overnight.

3. Perhaps, also, for new loans created during the day, that the automatic emails to the borrower be sent the same day and not
the next.

This way, three or four tasks would configured in Windows:




1. At midnight with the argument No_Alerts

2. At 7:00 A.M. with the argument AlertsOnly

3. At 1:00 P.M. with the argument AlertsOnly

3 bis. At 4:00 P.M. with the argument AlertsOnly

To add the "REPORTS =" argument to a task in the Windows Task Scheduler, all you need to do is add the report’s unique identifier

number you wish to generate automatically in the window provided for this purpose during the "Start a program" step:

¥ Automatic Report Setup

rReport i

Identifier: 22
Type: Record List - Mame: Ageing

Description:

- Dates
0 Full report
) From Origination date to Current* Date
i @ Last 5 Day(s) ¥ | to Current* Date
() Current* date only (0:00 to midnight)

Current [

Create Basic Task Wizard

@ Start a Program

Create a Basic Task

Trigger Program/script:
Eaily |"C:\Users\marcp\OneDrive\Bureau\S.Z bonne BDWMLM_Overnight_tasl
Action
Add arguments (optional):
Finish

Start in (optional):

Log of tasks performed
The "Open LOG" link (top right) allows the user to see the tasks completed and errors (in pink).

Browse...

It is suggested to review this history occasionally, especially to ensure backups have been completed.

¥ Overnight Tasks Log = (=] X
b Start =
Date Time End task Time Task type Success Message Error Error time Error message 3
14121120 T | WAL WUIDUIUY | IovdLELdi W10 UdLe CaItUations SUCCEss It ' =]
12/27/2017 | 00:41:08 00:45:29 Backup ¥ Backup successful. = e
12/26/2017 | 00:50:04 00:54:50 Aerts [V Aerts generation successful. Fe
12/26/2017 | 00:45:35 00:50:03 ToDateCalc [V To Date calculations successful. |
12/26/2017 | 00:41:08 00:45:35 [Backup [V Backup successful. =
12/25/2017 | 00:50:07 00:54:53 Aerts [V Aerts generation successful. | Y
12/25/2017 | 00:45:38 00:50:07 ToDateCalc [V To Date calculations successful. r
12/25/2017 | 00:41:08 00:45:37 Backup [V Backup successful. >
12/24/2017 | 00:49:55 00:54:38 Aerts |V AMerts generation successful. I~
12/24/2017 | 00:45:27 00:49:55 ToDateCalc [V To Date calculations successful. [
12/24/2017  00:41:08 00:45:27 Backup [V Backup successful. I~
12/23/2017  00:49:54 00:54:39 Aerts [V |Aerts generation successful. w
12/23/2017 | 00:45:19 00:49:54 ToDateCalc [V To Date calculations successful. I=
12/23/2017 | 00:41:05 00:45:19 Backup [V Backup successful. I~
12/22/2017 | 00:51:08 00:55:48 Aerts [V AMerts generation successful. I
12/22/2017 | 00:46:35 00:51:08 ToDateCalc |V ToDate calculations successful. I
12/22/2017 | 00:41:08 00:46:35 Backup [V Backup successful. ~
12/21/2017 | 16:41:36 16:41:51 Aerts [V AMerts generation successful. I
12/21/2017 | 16:41:35 16:41:35 ToDateCalc [V ToDate calculations already done today (1 [~
Backup failed, error message below.
12/21/2017 16:40:53 Backup = ~ 20w mm:’m?’gmwm T
CaUsersimare -
GelinasiDesktop\DLINK-058AC7 \Volume_1\Backups\_MLM_Automz
12/21/2017 | 14:45:03 14:45:19 Aerts [V AMerts generation successful. |
1212472047 | 14- 4500 14:45:02 TaDataral [Z__TaDat, innc aleaady dana badaw i1 [ E'
* Mouse right clic to export
Total logs : 147 Delete all message logs older than: B Delete message— I Exit—[0]

Last updated: June 28, 2023

10.




